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Intisari 
 

Di zaman yang semakin modern saat ini menuntut suatu industri perlu melakukan 
perencanaan matang dalam membangun konstruksi sistem perpipaan yang baik guna menjaga 
kualitas proses produksinya, baik di bidang oil & gas plant, petrochemical plant dan power plant. 
Dengan memanfaatkan teknologi yang ada, pembangunan konstruksi sistem perpipaan di suatu 
plant (pabrik), dapat berjalan dengan baik dalam waktu yang lebih cepat. Salah satunya dengan 
menggunakan aplikasi software berbasis komputer yaitu SmartPlant 3D (SP3D).Aplikasi software 
SmartPlant 3D (SP3D) merupakan salah satu aplikasi yang dapat memberikan informasi berupa 
detail lengkap sebuah rancangan suatu plant.  

Dalam menggunakan aplikasi SP3D, data yang dibutuhkan untuk melakukan pemodelan 
adalah rancangan gambar-gambar teknik meliputi gambar 2D equipment, gambar 2D P&ID, 
gambar 2D structure, gambar 2D plot plan, dan gambar 2D piping isomteric. Pemodelan dimulai 
dengan log in pada aplikasi SP3D, selanjutnya membuat hierarchy, setelah itu dapat dilakukan 
pemodelan untuk equipment, piping maupun structure. Setelah melakukan pemodelan, langkah 
selanjutnya adalah mengestimasi berat setiap komponen sistem perpipaan, structure dan 
equipment. Berat komponen sistem perpipaan dapat dicari dengan menggunakan aplikasi 
Pipedata-Pro versi 7.02.0031 dan berat equipment dapat dicari menggunakan perhitungan. 

Hasil pemodelan menggunakan software SmartPlant 3D (SP3D) antara lain gambar 2D 
dan 3D general plan, gambar 2D plot plan, gambar 2D dan 3D equipment, gambar 3D  piping dan 
piping isometric, gambar 2D dan 3D structure. Selanjutnya ada material take off (MTO) dari piping 
dan structure yang berisi informasi mengenai jenis komponen, spesifikasi komponen, dimensi 
komponen, material komponen dan berat komponen. Berat total dari komponen sistem perpipaan, 
structure dan equipment secara berturut-turut sebesar 13683,11 kg, 102889,91 kg dan 110558,44 
kg. 

 
 

Kata kunci : Software SmartPlant 3D (SP3D), Equipment, Piping Isometric, Structure, Plot plan 
 

  

1. PENDAHULUAN  

  
Di dalam dunia industri pada saat ini, banyak perusahaan industri khususnya yang 

beresktor energi berlomba-lomba untuk menjadi yang terbaik di bidangnya, namun tetap 
mempertimbangkan kualitas kehandalan, mutu dan performa suatu sistem operasi yang 
berjalan di dalamnya. Untuk mempertahankan hal tersebut, baik industri di bidang oil and 
gas plant, petrochemical plant, power plant, maupun offshore mining plant saat ini harus 
memiliki sistem perpipaan yang baik untuk keberlangsungan proses produksi yang 
berjalan pada industri tersebut. Dalam memenuhi kebutuhan tersebut suatu industri 
dapat menggunakan aplikasi berbasis komputer yang menunjang teknik rancang bangun 
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dan desain khususnya pada sistem perpipaan. Salah satu aplikasi software yang dapat 
digunakan adalah SmartPlant 3D (SP3D). 

Sistem perpipaan di dalam industri merupakan fasilitas yang memungkinkan suatu 
industri tersebut untuk melakukan proses produksi, sistem perpipaan dapat disebut juga 
suatu sistem yang digunakan untuk melakukan transport fluida kerja antar equipment 
(peralatan) dalam suatu pabrik (plant) atau dari suatu tempat ke tempat yang lain 
sehingga proses produksi dapat berlangsung. Untuk membuat dan merancang suatu 
sistem perpipaan dibutuhkan perancangan gambar-gambar teknik yang tepat seperti 
gambar equipment, gambar isometric pipa, gambar process flow diagram, gambar plot 
plan dan gambar structure, sehingga sistem perpipaan dapat dibangun sesuai dengan 
kebutuhan industri itu sendiri. 

SmartPlant 3D (SP3D) adalah software desain dengan multi user yang mengakses 
database dengan memberikan informasi berupa detail lengkap sebuah rancangan kilang 
industri (process plant) yang telah diakui oleh dunia internasional sebagai aplikasi desain 
3D untuk simulasi konstruksi dan sistem perpipaan. Keunggulan SP3D antara lain dapat 
menampilkan gambar 3 dimensi (3D), memberikan informasi berupa material yang 
digunakan pada setiap masing-masing disiplin, gambar isometric untuk disiplin piping, 
drawing 2 dimensi (2D), dan dijadikan sebagai model review untuk mengetahui adanya 
clash atau tidak [1]. Software ini juda dapat membantu engineer dalam mengontrol 
proyek-proyek rekayasa, desain dan kostruksi, yang tidak terbatas hanya pada plant 
onshore dan offshore. 

Disamping kegunaan SP3D di atas, terdapat beberapa aplikasi perancangan lainnya 
yang dapat berinteraksi dan mendukung untuk pengerjaan desain SP3D antara lain 
AutoCAD, Caesar, XSteel, MicroStation, Spoolgen dan bahkan dapat memanfaatkan 
keunikan yang terdapat pada Microsoft Office Excel.  

 

2.   TINJAUAN PUSTAKA 

Sistem perpipaan dapat disebut juga suatu sistem yang digunakan untuk melakukan 
transport fluida kerja antar equipment (peralatan) dalam suatu pabrik (plant) atau dari 
suatu tempat ke tempat yang lain sehingga proses produksi dapat berlangsung [2]. 
Perancangan sistem perpipaan yang baik dan aman sangat dibutuhkan untuk menjamin 
kelangsungan dari proses serta menjamin umur pemakaian dari sistem pemipaan sesuai 
dengan siklus rancangan [3]. Di dalam desain dan layouting pada industri komplek, 
dibutuhkan ribuan gambar detail rancangan sistem perpipaan untuk membantu 
pembuatan konstruksi sistem perpipaan tersebut [4]. Gambar perpipaan pada 
perencanaan konstruksi plant terdiri dari beberapa bentuk penggambaran yang berbeda-
beda [5].  

Di setiap sistem perpipaan terdapat komponen-komponen yang mendukung 
jalannya proses sistem perpipaan tersebut, setiap komponen perpipaan ini dibuat 
berdasarkan spesifikasi dan standar untuk kebutuhan di setiap pemakaian yang berbeda. 
Komponen sistem perpipaan secara umum dibagi menjadi beberapa kelompok : 

1) Pipa. 
2) Fitting (elbow, tee, reducer, flange, katup, dan lain-lain). 
3) Instrumentasi (peralatan untuk mengukur dan mengendalikan parameter aliran 

fluida, seperti : temperatur, tekanan, laju aliran massa, level ketinggian, dan 
sebagainya). 

4) Peralatan/equipment (bejana tekan, tungku pembakaran, pompa, kompresor, 
dan sebagainya). 

5) Penyangga pipa (pipe support, pipe hanger). 
6) Komponen khusus (strainer, drain, vent, dan sebagainya). 

 Desain, kontruksi, operasi, dan perawatan untuk berbagai jenis sistem perpipaan 
harus melibatkan pengetahuan tentang dasar pokok perpipaan, material, memerhatikan 
desain khusus dan umum, fabrikasi dan penggunaan, pemeriksaan, pengujian dan 
inspeksi yang sudah ditetapkan pada aturan yang sudah dibuat di lingkup lokal maupun 
global [6].  
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3. METODE PEMODELAN  

Dalam mendesain suatu project menggunakan software SP3D, terdapat tahapan-
tahapannya sehingga akan menghasilkan output yang sesuai dari perencanaan 
sebelumnya. Tahapan-tahapan desain sesuai dengan diagram alir yang ditunjukkan pada 
Gambar 1. 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mulai 

Persiapan data 

1. Gambar P&ID 

2. Gambar equipment 

3. Gambar structure 

4. Gambar isometri pipa 

5. Gambar plot plan 

Mendesain 3D equipment 

Mendesain 3D structure 

A 

Posisi beam dan 
brace tetap saat di 
refresh workspace 

Ya 

Tidak 

Mendesain 3D piping 

Muncul tanda seru (!) 
saat meng-output 

Gambar isometric pipa 

Ya 

Tidak 
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Gambar 1 Diagram alir pemodelan menggunakan software SP3D. 

 

4. PROSES PEMODELAN SP3D 

Langkah pertama yang dilakukan untuk mengoperasikan aplikasi SP3D adalah 
dengan membuka aplikasi SP3D, klik icon SP3D pada taskbar (lihat Gambar 2). 

 
 

Gambar 2. Login aplikasi SP3D. 
 

 Setelah masuk pada aplikasi SP3D, selanjutnya pilih Metric Unit. Gambar 3 
menunjukkan pemilihan unit SP3D. 

 
Gambar 3. Pemilihan unit SP3D. 

 
Sebelum melakukan pemodelan menggunakan software SP3D, terlebih dahulu 

membuat hierarchy sebagai susunan/penataan desain yang nantinya akan muncul pada 
kolom workspace explorer. 

Langkah pertama dalam pembuatan hierarchy yaitu dengan memfilter hierarchy. 
Pilih File > Define Workspace. Setelah itu muncul Define Workspace. Dalam pembuatan 

A 

Hasil pemodelan SP3D 

- Gambar 3D general plant 

- Gambar 3D equipment 

- Gambar 3D piping 

- Gambar 3D structure 

- Gambar isometri pipa 

- Gambar 2D equipment 

- Gambar 2D structure 

- MTO (material take-off) 

- Berat equipment dan piping 

Selesai 

Menghitung berat equipment dan piping 

Tidak 
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hierarchy baru maka langkah selanjutnya yaitu pilih Filter > Create New Filter. Gambar 4 
menunjukkan tampilan create new filter pada define workspace. 

 
Gambar 4. Create new filter pada define workspace. 

 
Setelah itu akan muncul new filter properties. Dalam new filter properties ini belum 

ada hiearachy yang dibuat atau masih bawaan/sample dari SP3D. Untuk membuat 
hierarchy sendiri sebelumnya edit kolom Name, isikan UMY 14. Untuk membuat 
hierarchy area baru, terlebih dahulu memilih area bawaan/sample dari SP3D sebagai 
langkah awal membuat hierarchy area sendiri. Gambar 5 menunjukkan tampilan new 
filter properties. 

 
Gambar 5. New filter properties. 

 
Setelah pilih oke maka akan kembali ke define workspace. Lalu pilih oke pada 

define workspace. Setelah itu akan muncul AREA TRAINNG pada workspace explorer 
yang merupakan hierarchy sample dari SP3D sebagai acuan/dasar untuk membuat 
hierarchy sendiri secara manual. Untuk membuat hierarchy sendiri secara manual yaitu 
dengan pilih Task > Systems and Specifications. . 

Setelah itu akan muncul systems and specifications. Dalam systems and 
specifications akan muncul area yang merupakan bawaan dari SP3D. Untuk membuat 
area baru, langkah awal yaitu pastikan hierarchy pada project-nya yaitu SP3D Train. 
Kemudian pilih create other system pada tool bar lalu pilih new area system. Gambar 6 
berikut menunjukkan cara pembuatan new area system. 

 
Gambar 6. Pembuatan new area system. 

 
 Setelah itu muncul hierarchy baru yaitu Area System-1-1101. Kemudian rename 
area system-1-1101 menjadi LATIHAN PROJECT. Langkah selanjutnya yaitu membuat 
unit system yang berada di bawah LATIHAN PROJECT. Caranya yaitu pastikan 
hierarchy pada LATIHAN PROJECT. Kemudian pilih create other system pada tool bar. 
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Lalu pilih New Unit System. Setelah itu rename unit system-1-1102 menjadi UNIT 
LATIHAN.  

Setelah membuat unit area baru, selanjutnya create disiplin sesuai dengan kasus 
yang akan dikerjakan yaitu EQUIPMENT, STRUCTURE & PIPING. Caranya yaitu 
pastikan hierarchy pada UNIT LATIHAN. Lalu pilih create other system pada tool bar, lalu 
pilih new equipment system. Kemudian rename equipment system 1-1101 menjadi 
EQUIPMENT. 
 Pembuatan disiplin selanjutnya yaitu STRUCTURE & PIPING, caranya sama 
dengan pembuatan disiplin EQUIPMENT. Gambar 7 menunjukkan tampilan hasil 
pembuatan disiplin equipment, piping dan structure. 

 
Gambar 7. Hasil pembuatan disiplin equipment, piping dan structure. 

 
Setelah hierarchy tersusun, langkah selanjutnya yaitu kembali ke tampilan awal. 

Caranya yaitu pilih Tasks > Common. Setelah kembali ke tampilan awal maka akan 
muncul dua area pada workspace explorer yaitu AREA TRAINING dan LATIHAN 
PROJECT yang ditunjukkan pada Gambar 8. 

 
Gambar 8. Tampilan workspace explorer. 

 
Langkah selanjutnya yaitu filter ulang area, karena area yang dibutuhkan hanya 

LATIHAN PROJECT. Caranya yaitu klik File > Define Workcpace. Pastikan kolom Filter 
pada UMY 14 > Properties > LATIHAN PROJECT. Kemudian klik ok.  

Setelah filter ulang, maka area yang muncul pada workspace explorer hanya 
LATIHAN PROJECT, yang ditunjukkan pada Gambar 9. 

 
Gambar 9. Tampilan workspace explorer baru. 

 
4.1 Pemodelan Equipment T-101 (Tangki Penyimpanan) 

Sebelum melakukan pemodelan equipment, perlu diperhatikan bahwa posisi task  
harus sudah pada posisi equipment and furnishing. Equipment T-101 terdiri dari 
beberapa bentuk yaitu : roof (1 buah), shell (1 buah), foundation (1 buah) dan nozzle (5 
buah). Adapun langkah-langkah dalam pemodelan T-101 yaitu sebagai berikut : 

 
4.2 Pembuatan hierarchy equipment T-101.  

 Hierarchy pada equipment, selanjutnya pada tool design pilih place design 
equipment > equipment > process > vertical vessel > vertical drum with leg. Setelah itu 
akan muncul design equipment properties.  Isikan nama = T-101, system = EQUIPMENT, 
lalu pilih oke. Gambar 10 menunjukkan tampilan design equipment properties. 
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Gambar 10. Tampilan design equipment properties. 

 
Setelah itu pada menu bar pilih pin point untuk memasukkan nilai koordinat 

sesuai dengan yang ada pada plot plan yaitu north (N) = 21000 mm, east (E) = 10000 
mm, elevation (El) = 300 mm. Kemudian klik kiri pada layar. 

Di dalam hierarchy equipment T-101 terdiri dari 3 sub-equipment yaitu BODY, 
DATUM, dan NOZZLE.  

 
4.2.1 Pembuatan sub-equipment BODY T-101. 

Langkah awal pembuatan sub-equipment BODY yaitu klik hierarchy 
equipment T-101, kemudian pilih place design equipment component pada tool design. 
Selanjutnya pilih vertical drum seperti pada Gambar 11 berikut. 

       
Gambar 11. Pembuatan sub-equipment BODY T-101. 

 
Kemudian diminta untuk memasukkan nilai kooordinat. Nilai koordinat BODY 

T-101 sama dengan koordinat hierarchy T-101. 
 

4.2.2 Pembuatan sub-equipment NOZZLE T-101 
Langkah dalam pembuatan sub-equipment NOZZLE T-101 yaitu klik hierarchy 

T-101, kemudian pilih place design equipment component pada tool design. Selanjutnya 
pilih manway davit vertical cover seperti pada Gambar 12 berikut. 

         
Gambar 12. Pembuatan sub-equipment NOZZLE T-101. 
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Kemudian diminta untuk memasukkan nilai kooordinat. Nilai koordinat 
NOZZLE T-101 sama dengan koordinat hierarchy T-101. 

 
4.2.3 Pembuatan sub-equipment DATUM T-101 

Pembuatan sub-equipment datum T-101 yaitu dengan klik hierarchy T-101, 
kemudian pilih shapes pada tool design, seperti pada Gambar 13 berikut. 

  
Gambar 13. Pembuatan sub-equipment DATUM T-101. 

 
Kemudian masukkan nilai koordinat yang nilainya sama dengan nilai koordinat 

hierarchy T-101. Rotate DATUM T-101 dengan axis direction N/S masukkan -90 derajat. 
Jangan lupa klik fast rotate. Kemudian pilih close.  

 
4.2.4 Proses Pemodelan Equipment T-101 

Setelah selesai membuat sub-equipment BODY, NOZZLE, dan DATUM, langkah 
selanjutnya yaitu pemodelan equipment T-101. Adapun langkah-langkahnya sebagai 
berikut. 

1) Pastikan klik terlih dahulu sub-equipment BODY T-101. Kemudian pilih circular 
cylinder pada menu shapes yang ada pada tool design. Selanjutnya isi name = 
FOUNDATION, A = 300 mm, B = 10000 mm. Kemudian pilih ok. Setelah itu 
masukkan koordinat sementara yaitu N = 0, E = 0, El = 0. Lalu klik sembarang 
tempat. Rotate FOUNDATION T-101 dengan axis direction N/S sebesar -90 
derajat. Jangan lupa pilih close. Gambar 14 menunjukkan hasil 3D pemodelan 
foundation. 

 
Gambar 14. Hasil 3D pemodelan foundation. 

 
2) Selanjutnya membuat shell, pastikan hierarchy pada sub-equipment BODY T-101 

kemudian pilih circural cylinder pada menu shapes. Selanjutnya isikan name = 
SHELL, A = 10000 mm, B = 9000 mm. Kemudian pilih oke. Setelah itu masukkan 
koordinat sementara E = 0, N = 0, El = 0. Rotate HEAD dengan axis direction N/S 
sebesar 90 derajat. Lalu pilih close. Gambar 15 menunjukkan hasil 3D 
pemodelan shell. 
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Gambar 15. Hasil 3D pemodelan shell. 

 
3) Selanjutnya membuat roof dibuat dengan memilih rectangular circural cone pada 

menu shapes. Kemudian isi name = ROOF,  A = 1500 mm, B = 9000 mm, C = 0 
mm. Kemudian pilih oke. Setelah itu masukkan koordinat sementara E = 0, N = 0, 
El = 0. Rotate SHELL dengan axis direction N/S sebesar 90 derajat. Lalu pilih 
close. Gambar 16 menunjukkan hasil 3D pemodelan shell. 

  
Gambar 16. Hasil 3D pemodelan roof. 

 
4) Langkah selanjutnya adalah pembuatan nozzle. Sebelum pemodelan nozzle 

dimulai, terlebih dahulu membuat DATUM NOZZLE. Pastikan hierarchy pada 
sub-equipment NOZZLE T-101 kemudian pilih datum pada menu shapes. 
Masukkan koordinat DATUM NOZZLE yaitu N = 0, E = 0, El = 0. Kemudian rotate 
dengan axis direction N/S sebesar -90 derajat. Lalu pilih close. Equipment T-101 
terdiri dari 2 buah manhole dan 3 nozzle. Berikut ini merupakan input data yang 
dimasukkan untuk nozzle equipment T-101 sebagai contoh nozzle 1 (N1). 
Langkah pertama klik DATUM NOZZLE, kemudian pilih place nozzle pada tool 
design. Kemudian ubah name = N1, nominal size = 4 inch, pressure rating = 
#150 RF, nozzle length = 4700 mm, location > placement type = radial, N1 = 300 
mm, N2 = 4700, OR = 90 derajat. Setelah itu pilih oke. Gambar 17 berikut 
menunjukkan tampilan nozzle properties untuk nozzle. 
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Gambar 17. Nozzle properties untuk nozzle. 

 
Untuk input data nozzle yang lain tinggal mengubah spesifikasi sesuai dengan 
data yang ada di gambar 2D. 
 
Gambar 18 menunjukkan hasil 3D pemodelan equipment T-101 yang terdiri dari 
beberapa bentuk yaitu : roof (1 buah), shell (1 buah), foundation (1 buah) dan 
nozzle (5 buah). 

 
Gambar 18. Hasil 3D pemodelan equipment T-101. 

 
Setelah selesai melakukan pemodelan BODY T-101 berupa 1 buah foundation, 

1 buah shell, 1 buah roof dan 5 buah nozzle maka langkah selanjutnya yaitu 
memindahkan koordinat equipment T-101 ke koordinat aslinya sesuai dengan plot plan. 
Caranya yaitu select under  BODY T-101 dan under DATUM T-101 seperti pada Gambar 
19 berikut. 

 
Gambar 19. Pemilihan hierarchy equipment T-101. 

 
Setelah itu pilih move pada menu toolbar. Pilih titik awal pemindahan seperti 

yang ditunjukkan pada Gambar 20, selanjutnya masukkan nilai koordinat asli/sesuai 
dengan yang ada pada plot plan yaitu E = 10000 mm, N = 21000 mm, El = 300 mm. 
Jangan lupa centang fast move. Lalu klik kanan sembarang tempat. Gambar 20 
menunjukkan pemindahan equipment T-101 ke koordinat sebenarnya. 
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Gambar 20. Pemindahan equipment T-101 ke koordinat sebenarnya. 

 
Setelah selesai melakukan pemodelan equipment T-101, maka dapat 

dilanjutkan melakukan pemodelan equipment yang lain dengan cara yang hampir sama. 
 

4.3  Pemodelan pipa 4-WP-10005-A150-N 
Dari gambar P&ID dapat diketahui bahwa pipa 4-WP-10005-A150-N merupakan 

pipa yang menghubungkan antara nozzle N1 pada equipment T-101 menuju nozzle N1 
pada equipment P-102A/B. Pemodelan jalur pipa ini berdasarkan gambar 2D isometrik 
perpipaan dengan line number 4-WP-10005-A150-N. Adapun maksud dari pipa 4-WP-
10005-A150-N adalah: 

- 4 = Nominal pipe size (inch) 
- WP = Line service 
- 10005 = Sequence number 
- A150 = Specification class 
- N = Type insulation 

Sebelum melakukan pemodelan jalur pipa 4-WP-10005-A150-N, maka terlebih 
dahulu membuat hierarchy line number yaitu dengan klik kanan pada hierarchy piping > 
new system > new pipeline. Setelah itu muncul property pages dialog dan isi nama 4-
WP-10005-A150-N seperti pada Gambar 21 berikut. 

  
Gambar 21. Property pages dialog pipa WP-10005-A150-N. 

 
Setelah selesai membuat hierarchy line number maka selanjutnya routing pipa. 

Caranya yaitu : 
- Ubah task ke piping. 
- Pilih route pipe pada tool design untuk membuat pipa. 
- Pilih insert component pada tool design untuk membuat komponen. 
- Tentukan titik awal di mana routing pipa dimulai yaitu N1 pada equipment T-101. 
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Gambar 22 menunjukkan Penentuan titik awal routing pipa pada N1 equipment T-101. 

   
Gambar 22. Penentuan titik awal routing pipa pada N1 equipment T-101. 

 
Setelah menentukan titik awal dimana routing pipa dimulai, selanjutnya muncul 

tabel new pipe run seperti pada Gambar 23. Isikan data sebagai berikut : 
- Posisi pipeline pada hierarchy WP-10005-A150-N. 
- Nama = PIPE RUN 1. 
- Untuk ukuran diameter menyesuaikan dengan ukuran nozzle.  
- Setelah itu tekan ok. 

 
Gambar 23. New pipe run 1. 

 
Selanjutnya pilih tipe komponen yang akan dibuat, kemudian pilih gate valve 

pada kolom type, setelah itu klik finish. Gambar 24 menunjukkan langkah pembuatan 
komponen gate valve. 

   
Gambar 24. Langkah pembuatan komponen gate valve 1. 

 
Selanjutnya pilih flange pada kolom type, kemudian finish. Gambar 25 

menunjukkan hasil pembuatan flange. 
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Gambar 25. Hasil pembuatan flange. 

 
Setelah membuat flange, langkah selanjutnya adalah membuat pipa. Pilih route 

pipe pada tool design, kemudian tentukan titik koordinat sementara (0,0) untuk 
memudahkan menentukan panjang pipa. Tempatkan titik koordinat sementara (0,0) pada 
face flange, Gambar 26 menunjukkan posisi titik koordinat sementara. 

 
Gambar 26. Posisi titik koordinat sementara. 

 
Selanjutnya masukkan nilai dari panjang pipa yang akan dibuat pada kolom E 

(east) = 849 mm, karena arah dari pipa menuju ke arah east, kemudian klik kiri pada 
layar. Gambar 27 menunjukkan hasil pembuatan pipa. 

 
Gambar 27. Hasil pembuatan pipa 1. 

 
Selanjutnya membuat komponen tee, pilih insert component, kemudian pilih tee 

pada kolom type, posisi tee diubah mengikuti pada Gambar 28. Selanjutnya kolom run 
pilih new pipe run, isi name = PIPE RUN 2, kemudian reference position diubah ke origin, 
kolom angle diisi 90, kemudian klik finish. 

 
Gambar 28. Simbol untuk mengubah posisi tee. 
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Gambar 29 menunjukkan hasil dari pembuatan komponen tee. 

 
Gambar 29. Hasil pembuatan tee. 

Selanjutnya membuat pipa ke arah nozzle N1 pada equipment P-102A. Pilih 
route pipe pada tool design, lalu klik nozzle N1 pada equipment P-102A untuk menjadi 
acuan panjang pipa (lihat Gambar 30). 

 
Gambar 30. Titik acuan pembuatan pipa 2. 

 
Gambar 31 menunjukkan hasil pembuatan pipa 2. 

 
Gambar 31. Hasil pembuatan pipa 2. 

 
Selanjutnya membuat komponen flange pada nozzle N1 equipment P-101A, pilih 

insert component, pilih posisi nozzle N1 equipment P-101A untuk menjadi tempat 
dibuatnya flange. Selanjutnya akan muncul tabel new pipe run, isi name = PIPE RUN 3, 
kemudian klik ok. Selanjutnya pilih flange pada kolom type, kemudian klik finish. Gambar 
32 menunjukkan hasil pembuatan flange nozzle N1 equipment P-101A. 
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Gambar 32. Hasil pembuatan flange nozzle N1 equipment P-101A. 

 
Selanjutnya membuat eccentric reducer, klik insert component pada tool design, 

kemudian pilih eccentric reducer pada kolom type. Kemudian pilih select grhapically pada 
kolom run, pilih pipa yang ditunjukkan pada Gambar 33, isi nilai sebesar 180 pada kolom 
angle untuk merotasi eccentric reducer, setelah itu klik finish. 

 
Gambar 33. Acuan pipa untuk membuat eccentric reducer. 

 
Gambar 34 menunjukkan hasil pembuatan eccentric reducer. 

 
Gambar 34. Hasil pembuatan eccentric reducer. 

 
Selanjutnya pilih route pipe pada tool design untuk membuat pipa yang 

menghubungkan pipa 2 ke eccentric reducer. Gambar 35 menunjukkan posisi untuk 
membuat pipa 3. 

 
Gambar 35. Posisi pipa 3. 
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Gambar 36 menunjukkan hasil pembuatan pipa 3 dan pipa untuk line number 4-

WP-10005-A150-N. 

 
Gambar 36. Hasil pembuatan pipa 4-WP-10005-A150-N. 

 

5. PEMBAHASAN 

Setelah melakukan pemodelan menggunakan software SP3D maka didapat hasil 
pemodelan berupa gambar 2D dan 3D meliputi equipment, piping dan general plant.  

 
1. Equipment T-101 

Gambar 37 menunjukkan hasil 
pemodelan 3D equipment T-101 storage 
tank. 

2. Equipment T-102 
Gambar 38 menunjukkan hasil 

pemodelan 3D equipment T-101 storage 
tank. 

Gambar 37. Hasil pemodelan 3D 
equipment T-101. 

Gambar 38. Hasil pemodelan 3D 
equipment T-102. 

  
  

3. Equipment E-101 
Gambar 39 menunjukkan hasil 

pemodelan 3D equipment E-101 heat 
exchanger. 

4. Equipment E-102 
Gambar 40 menunjukkan hasil 

pemodelan 3D equipment E-102 air fan 
exchamger. 

  

Gambar 39. Hasil pemodelan 3D 
equipment E-101. 

Gambar 40. Hasil pemodelan 3D 
equipment E-102. 
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5. Equipment V-101 
Gambar 41 menunjukkan hasil 

pemodelan 3D equipment V-101 
horizontal vessel. 

6. Equipment V-102 
Gambar 42 menunjukkan hasil 

pemodelan 3D equipment V-102 vertical 
vessel. 

 

 
Gambar 41. Hasil pemodelan 3D 

equipment V-101. 
Gambar 42. Hasil pemodelan 3D 

equipment V-102. 
 

7. Equipment P-101 
Gambar 43 menunjukkan hasil 

pemodelan 3D equipment P-101 
centrifugal pump. 

8. Equipment P-102 
Gambar 43 menunjukkan hasil 

pemodelan 3D equipment P-101 
centrifugal pump. 

 
 

Gambar 43. Hasil pemodelan 3D 
equipment P-101. 

Gambar 44. Hasil pemodelan 3D 
equipment P-102. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



JMPM: Jurnal Material dan Proses Manufaktur - Vol.XXX, No.XXX, XXX  
http://journal.umy.ac.id/index.php/jmpm 

 
                                                                                                                                                                                                                          

JMPM | Jurnal Material dan Proses Manufaktur 18 

 

9.     Equipment C-101 
Gambar 45 menunjukkan hasil 

pemodelan 3D equipment C-101 vertical 
column. 

 
 

Gambar 45. Hasil pemodelan 3D 
equipment C-101. 

 
11.   Pipa 4-GS-10007-A150-N. 

Gambar 47 menunjukkan hasil 
pemodelan 3D pipa 4-GS-10007-A150-N. 

 

 
Gambar 47. Hasil pemodelan 3D 

pipa 4-GS-10007-A150-N. 
 
 
 
 
 
 
 
 
 
 
 
 

10.  Equipment C-103 
Gambar 46 menunjukkan hasil 

pemodelan 3D equipment C-103 vertical 
column.  

 
 

Gambar 46. Hasil pemodelan 3D 
equipment C-103. 

 
12.  Pipa 4-GS-10009-A150-N. 

Gambar 48 menunjukkan hasil 
pemodelan 3D pipa 4-GS-10009-A150-N. 

 

 
Gambar 48. Hasil pemodelan 3D 

pipa 4-GS-10009-A150-N. 
 
 



JMPM: Jurnal Material dan Proses Manufaktur - Vol.XXX, No.XXX, XXX  
http://journal.umy.ac.id/index.php/jmpm 

 
                                                                                                                                                                                                                          

JMPM | Jurnal Material dan Proses Manufaktur 19 

 

13.   Gambar 3D General Plant 
Gambar 49 menunjukkan hasil pemodelan 3D general plant. 

 

 
Gambar 49. Hasil 3D pemodelan general plant. 
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14.   Gambar 2D equipment T-101. 
Gambar 50 menunjukkan hasil pemodelan 2D equipment T-101 storage tank. 

 
Gambar 50. Hasil pemodelan 2D equipment T-101. 

 
 

15.   Gambar isometrik pipa 3-WP-10006-A150-N 
Gambar 51 menunjukkan hasil pemodelan 2D pipa isometrik 4-GS-10006-A150-N. 

 
Gambar 51. Hasil pemodelan isometrik pipa 3-WP-10006-A150-N. 
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 Setelah melakukan pemodelan, maka dilakukan perhitungan berat komponen 
perpipaan, rangka dan equipment. Hasil perhitungan dapat dilihat pada tabel-tabel 
berikut. Tabel 1 menunjukkan hasil perhitungan berat rangka (pipe rack), Tabel 2 
menunjukkan hasil perhitungan berat komponen perpipaan, Tabel 3 menunjukkan hasil 
perhitungan berat equipment. 
 

Tabel 1. Hasil perhitungan berat rangka (pipe rack). 

No. Kategori 
Panjang 

(m) 

Luas area 
permukaan 

(m2) 

Berat 
(kg) 

1 Beam 500,09 1084,83 87074,31 

2 Column 113,64 269,49 21092,12 

3 Brace 73,07 158,52 12723,48 

Total 686,8 1512,84 120889,91 

 
 

Tabel 2. Hasil perhitungan berat komponen perpipaan. 

No. Kategori Quantity 
Berat  
(kg) 

1 Pipa 681,5 m 11046 

2 Fittings 181 buah 510,67 

3 Flanges 105 buah 637 

4 Valves 43 buah 1282,63 

5 Bolts 672 buah 178,75 

6 Gaskets 106 buah 28,76 

  Total 13683,81 

 
 

Tabel 3. Hasil perhitungan berat equipment. 

No. 
Tipe 

equipment 

Berat (kg) 

Shell Head 
Tube 
sheet 

Support 
skirt 

Saddle Nozzle Plate Total 

1 C-101 10437,58 1324,49 
 

3726,89 
 

411,62 
 

15900,58 

2 C-103 22161,63 3206,89 
 

6452,91 
 

243,9 
 

32065,33 

3 E-101 719,05 122,31 2996,58 
 

1545,41 56,96 
 

5440,32 

4 T-101 13321,6 4129,7 
   

461,83 369,86 18309,99 

5 T-102 13321,6 4129,7 
   

469,11 369,86 18317,27 

6 V-101 1881,65 300,28 
  

746 32,81 
 

2960,74 

7 V-102 11583,42 1471,45 
 

4095,69 
 

413,65 
 

17564,21 

       
Total (kg) 110558,44 
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6. KESIMPULAN 

Dari hasil pemodelan yang telah dibuat menggunakan software SmartPlant 3D, didapat 
beberapa gambar sebagai berikut: 

1. Gambar 2D dan 3D general plan (lihat gambar 6.1 dan gambar 6.2). 
2. Gambar plot plan (lihat gambar 6.3). 
3. Gambar 2D dan 3D equipment (lihat gambar 6.4 sampai gambar 6.23). 
4. Gambar 3D dan isometric piping (lihat gambar 6.24 sampai gambar 6.46). 
5. Gambar 2D dan 3D structure (pipe rack) (lihat gambar 6.47 dan gambar 6.48). 
6. MTO (material take-off), ditunjukkan pada tabel 6.11 dan tabel 6.12 yang berisi 

informasi mengenai: 
a. Jenis komponen. 
b. Spesifikasi komponen. 
c. Panjang dan ukuran komponen. 
d. Material komponen. 
e. Ditambah berat masing-masing komponen. 

7. Dari perhitungan yang telah dilakukan didapat berat total sebagai berikut: 
a. Berat total equipment sebesar 110558,44 kg. 
b. Berat total perpipaan sebesar 13683,31 kg. 
c. Berat total structure sebesar 102889,91 kg. 
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